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Overview 

What is NEO Email Finder 

Stop Searching, Start Finding Your Emails 

Happy with Outlook but struggling to find your older emails back? 

Stop searching and start finding your emails with NEO Email Finder. As a companion product 
of Outlook NEO Find runs unnoticed in the background keeping track of every move as email 
arrives, goes out and is stored away in your filing system. 

NEO FIND organizes all emails automatically in the most logical and intuitive way people 
think about their messages: around the correspondent involved in the email communication. 
Just enter (part of) the name of the Correspondent and all emails are available, both sent 
and received. 

Advanced filtering combined with a lightning fast search facility will bring up every email 
within seconds to your attention – independent where they are located in your entire Outlook 
system or how complex your filing system may be.  

Finding messages is a breeze 

Your messages automatically appear exactly where you would expect them: at the 
Correspondent who was involved in the conversation. That makes finding them completely 
intuitive: no more need to search your emails as they are right where they should be. And 
when you do need to add a little search, our patented search technology is lightning fast. 

The only tool NOT searching for your emails  

NEO Find: The only tool available which is not searching for your emails, but is automatically 
organizing them so you can find your emails where you expect them to be 

Companion product for Microsoft Outlook 

NEO Email Finder is a companion product for Microsoft Outlook 97, 98, 2000, 2002(XP), 
2003 and 2007. It works with Exchange, POP3 and IMAP message stores linked to Outlook.   

How NEO Works with Microsoft Outlook 

NEO is an add-on product to Microsoft Outlook and works with Outlook 97, 98, 2000, 2002, 
2003, 2007 and Exchange Servers 5.5, 2000, 2003 and 2007. 

A single Catalog for all your Outlook message stores 

Within Outlook you will normally want to keep multiple message stores: your mailbox for 
arriving messages, your filing system and probable one or more archive message stores. 
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NEO Find will create a single Catalog, holding references to all your emails throughout the 
entire Outlook system. 

Your email messages are only indexed and not duplicated in NEO – the messages remain 
stored in your Outlook or Exchange Server message stores. 

Like Outlook, NEO interfaces with your underlying message stores. When messages arrive 
into your message store, NEO is notified. When you send or delete messages, your NEO 
Catalog is updated in exactly the same way. 

Indexing and the Catalog 

NEO works by creating indexes to your messages and storing the indexes in a separate 
NEO catalog. Whenever messages are sent, received or updated in the message store, NEO 
automatically updates the indexes in the catalog.  

In NEO Find you can add all your message stores to become completely independent of the 
exact storage location within Outlook. 

How NEO works with Exchange Server 

NEO Find works with Microsoft Exchange Server mailboxes. 

Here are some notes about using NEO Find with Exchange Server: 

NEO is a client-side product 

That means NEO installs and operates completely on your computer. There is nothing about 
NEO that gets installed on the server or that is related to Exchange Server. In fact, Exchange 
Server is completely unaware of NEO. 

You can organize your Mailbox, your PSTs and IMAP message stores 

If you are using NEO Find you can include your mailbox and as many PSTs or IMAP 
message stores as you like in your catalog. NEO Find will give you a seamless view to all 
your messages. NEO Find makes it appear as though all your emails are in one single 
location. 

Using your offline message store (OST) 

Using Offline mode or Cached Exchange Mode will not affect organization of your messages 
within NEO Find. You can work as you always have while NEO Find keeps perfect track of 
every move.     
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Getting Started 

Ways to start NEO  

It's best to start NEO Find when Outlook starts and keep it running 

It is recommended to start NEO Find when starting Outlook. You can configure NEO Find to 
start when Outlook is started under Tools | Options | General tab. When you keep NEO Find 
running with Outlook, it keeps track of all message coming in/going out while running 
unnoticed in the background. When looking for a message you are always sure NEO Find is 
fully in sync with Outlook. 

NEO Find and the system tray 

When minimizing NEO Find, it will hide in the system tray (the area where also the computer 
clock is located). Clicking the NEO Find icon will open and bring NEO Find to the foreground 
ready to find your messages.  

You can configure NEO Find to minimize and hide in the system tray when starting setting 
this option in Tools | Options. This way NEO Find will never be in your way when started 
automatically by Outlook. 

Right-clicking the NEO Find icon in the System Tray opens a small menu with following 
options:  

 

“Options” will open NEO Find with the Options menu open (from the Tools menu). 

 

“Open Outlook” will open Outlook, even when Outlook has not started in the 
foreground or when Outlook was already closed. 

 

“Open NEO Find” (default) opens NEO Find. 

 

“Exit” will close down NEO Find without first opening it in the foreground. 

Start NEO manually 

After Outlook has started, you can also start NEO manually as you would any application: 

 

Click NEO Find from Start | Programs. 

 

Double-click the NEO Find icon on your desktop 

You can also start NEO Find from Outlook: Click Go to NEO Find on the Tools menu in 
Outlook, or click the NEO Find icon on the Outlook toolbar. 
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Closing NEO  

Closing NEO Find automatically with Outlook 

Closing Outlook through the File | Exit command will automatically close NEO Find as well. 
By customizing Outlook's toolbar the File | Exit command can be placed anywhere on the 
toolbar (e.g. to the right of the Help command). This will provide easy access and a single 
click to close both Outlook and NEO Find. For further details please refer to our Knowledge 
Base article T1181.  
Please keep in mind when closing Outlook's window (through the top right 'X'), Outlook's 
process is allowed to continue to run which will not force a close-down of NEO Find. 

Get help from within NEO  

Help is available from within NEO via: 

Tool tips         For a short description of toolbar commands and other command buttons, 
roll your mouse over the command. A tool tip will appear in about one 
second. 

Shortcuts       Available on the Help menu.  

Help system   Press F1; also available through "more info" and Help buttons inside NEO.  

Support and Feedback 

Click Send Email to Support on the Help menu.   
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Finding Emails 

A short introduction to NEO Find 

NEO Find’s main features.  

   View tabs  

All your emails are automatically organized 
into Correspondent folders for you.  

Enter your search words and NEO 
automatically searches across all your 
folders.  

You can view your Outlook folders just as in 
Outlook.  

   How NEO Find works   

NEO Find organizes all your emails automatically using Virtual Folders. 

No need to search for your emails as you know exactly where they are!   

Virtual 
Folders 

NEO displays the same message automatically for every 
Correspondent involved in the correspondence:      
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Finding Messages Quickly 

Use the Correspondent to find all your messages  

F5 

Click the Find Correspondent button on the toolbar 
(F5). If looking for Fiona Mackay, enter mac in the 
Folder List filter to short-list your Corresondents for 
easy selection.  

  

The green 
background color 
tells you that you 
have a Folder List 
filter active. 

To clear the filter, 
click Clear or press 
the Esc key. 

Search within a Correspondent folder  

F6 

Highlight a Correspondent and click the Search in 
(Correspondent) Folder button (F6) to quickly 
search through the mails from a single 
correspondent. 
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Search on Conversation  

F7 

Highlight a message (e.g,. with Subject Product 
Ideas) then click the Search on Conversation 
button (F7) to find all messages in the same 
conversation. 

 

Free Search  

F8 

Click the New Search button on the toolbar (F8) to 
do a full search through the entire Outlook system 
producing lightning fast results.    

You can even 
enter logical 
phrases like (car 
or bus) near 
accident. 

Or enter 
parameters to limit 
your search such 
as searching within 
a folder.   

Jump to containing folder(s)  

Right-click any message and choose Jump to 
Folder (Ctrl+J) to display all messages for the person 
from the email, in this case, Terry Johnston.  
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Options & Customizing   

Your Addresses 

About Your Addresses 

NEO needs to know which addresses are yours in order to automatically organize your 
messages. If not all your addresses are entered, your messages will not appear correctly. 

Note that NEO must know all your addresses - not just your currently used ones. Be sure 
to include your old addresses if you have messages that used them. 

Auto-detecting your addresses on catalog creation 

NEO automatically detects your addresses when you create a catalog, and you can add to 
the list NEO auto-detects. Addresses you enter are displayed in bold. 

Important Note:      NEO does not auto-detect addresses you use after creating the catalog. You 
have to enter these manually. 

Adding and removing addresses 

You can add addresses and you can remove addresses you add. Addresses NEO auto-
detects cannot be removed - however, you can choose not to include them by unchecking 
them). 

Click File menu | Your Addresses to keep your addresses up to date. 
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To add an address, click the Add command. POP3 email addresses are entered in the usual 
way (e.g., bcoopersmith@fbi_NY.com). Exchange Server addresses are entered in X.500 
format. 

Options 

 

General Options 

These options control NEO startup and other general settings. 
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Reading Pane Options 

These options relate to the Reading Pane.      
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Formatting Options 

These options set how items are formatted. 
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Miscellaneous options 

In this tab additional options can be set as described below.     

Other Ways to Customize 

  

Resizing the Reading Pane 

The Reading Pane can be positioned either at the bottom or to the right of the screen. This 
can be defined on View menu. Size of the Reading Pane can be changed to any desired size 
by dragging the pane separator to a new location. Switching off the Reading Pane is done 
through the View menu. 

Note that you don't have to see the List Pane messages in order to read them in the Reading 
Pane. You can use the following shortcut keys to move from message to message: 

Ctrl + Up                    Move to previous message  
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Ctrl + Dn                    Move to next message 

Resizing panes 

The panes in NEO can be resized. Place your cursor on the divider between the panes you 
want to resize and drag in desired direction. 

              

Changing Folder List sort order 

Each view can have its own sort order. Change the sort order by clicking one of the three 
buttons at the top right.   
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Changing Reading Pane fonts 

There are three message formats for the Reading Pane: HTML, Microsoft Outlook Rich Text, 
and Plain Text. Here's how the change the text characteristics. 

HTML messages 

Change the relative size of HTML text in two ways: 

         Click View menu | HTML Text Size. 

         Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 

Plain text messages 

Change the characteristics of Plain Text messages: 

         Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 

Microsoft Outlook Rich Text 

This message format cannot be modified in the Reading Pane. 

Moving the View tabs 

The NEO View tabs are positioned by default at the top of NEO because the tabs are easier 
to access there. You can position them at the top or the bottom of NEO, and you can choose 
to show the graphic symbols or not.  

Right-click on any part of the View tab and make your selection:  

            

Undocking and docking views 

When you start NEO for the first time you will see the default NEO workspace. In it, 
Correspondent view is in the top left panel, Search is below it. The List Pane is on the top 
right and the Reading Pane is below it. 

Optimize view positions to suit your workflow 

All view positions are configurable in NEO. You can undock any view and have it float above 
your workspace, you can dock the views onto the workspace surface in any position, you can 
change the order of the views on the View tab, and you can even hide a view. 

Save your Layout settings by exporting them 

When you have finalized setting your layout, it is best to save your layout settings by 
exporting them: View | Layout | Export Layout.... When it is necessary to reset your User 
Interface it is easy to restore your layout by importing the saved settings. 

How to reset the User Interface 

When you like to restart with the original layout, or when the User Interface needs to be 
reset: 



Page | 21   

Reset your layout             On the View menu, click Layout | Reset Layout. This will restore your 
layout to the default layout. 

Reset User Interface         Close NEO, click Ctr+Shift while double-clicking NEO icon to start the 
program. Confirm dialog to reset the User interface settings. 

Configuring your views 

The key point to remember when moving views is that a view can only be moved to a new 
location when it is undocked (floating). 

Undock a view that is currently docked on the Viewtab 

Double-click the view on the Viewtab. 

Undock a view that is currently docked on the workspace surface 

Double-click the titlebar of the view panel.  

Dock an undocked view back onto the Viewtab 

Drag the floating toolbar's titlebar on top of the Viewtab. As you move it over the tabs, 
drop it when  the insert indicator appears.  

Dock a view onto the workspace surface 

If it is not already undocked, double-click the tab (if on the Viewtab) or double-click the 
titlebar (if already docked on the workspace surface).  

Now that it is undocked, drag it by the titlebar to a dockable location. As you get close to 
a location it will snap into place with a line marker indicating its location. Drop it where 
you like.  

To move it so that it appears as a vertical column, place your cursor exactly on the 
juncture between two stacked panes (for example, the dividing line between the List 
Pane and the Reading Pane).  

Hide and restore a view 

To hide a view, press Alt+F4 when the view has the focus and is undocked.  

To restore a hidden view, go to View menu | click Views then click the view you want to 
make visible again.    

Adding and changing columns 

Column sort order 

Sort your messages by changing the column sort order.      

The indicator on the Date/Time column signifies the current sort column.  Click it again the 
change the sort direction, or click another column to change the sort column. 

Each folder can have a different sort order. 
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Changing column width 

Place your cursor at the start of a column until the resize icon appears (see below), then drag 
it right or left.   

When you change the column width for a view, it changes for all views except Attachment 
view which can be set independently. 

Changing column order 

Left-click drag the header of a column and drag it to the new location. 

Selecting which columns to display 

Right-click on any column. This list of available columns will appear for you to check or 
uncheck.  

List pane Name column  

The Name column in the List Pane shows the From name for incoming messages and the 
To name for outgoing messages. You can also choose to show Original name from message 
in this column. 

Here are the different ways to set this property:   
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Notice above that the folder name is very short to make more room for the original name. 
Also, specifying the folder name in upper case makes it stand out from the original name. 

You can set what's included in the Name column by right-clicking any Correspondent folder 
and choosing Folder Properties.  

Customizing toolbars and the menu 

By default, NEO has one menu and one or two default toolbars. You can customize these in 
several ways: 

         hide or show toolbars  

         move and undock toolbars  

         customize toolbars  
            - add commands 
            - modify commands 
            - remove commands 
            - reset toolbars 

         customize how the menu works  

It's useful to modify your toolbars to add commands you use frequently, or hide ones you use 
infrequently. You can even combine commands onto your own single toolbar to save space.  

Hide or show toolbars 

Right-click anywhere on the menu or toolbar and check or uncheck an toolbar to show or 
hide it. 
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Move and undock toolbars 

Place your cursor over the grip at the left of the toolbar and drag it out of position. As you 
drag it away it will become undocked (floating). You can resize and reshape it while 
undocked.  

As you move it near a dockable location it will snap into place.  

Customize toolbars 

Customize a toolbar by right-clicking anywhere on a toolbar and choosing Customize. 

You can create a new toolbar, rename and delete toolbars you create, and reset default 
toolbars back to their original state. 
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Add a command 

           

Select a command Category then location the desired Command. Drag and drop the 
command onto the toolbar in the location you want.  

Modify a command 

With the Customize dialog visible, right-click a command on the toolbar. A black box 
should appear around it to show you are in edit mode and the command edit will appear.  

            

Delete a command 

Modify a command as per above, and choose Delete.  

Customize menu and toolbar options 

You can change the behavior of the menu and toolbars by going to the Options tab of the 
Customize dialog. 
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Email Improperly Configured on your computer 

You may receive an error issued from Microsoft Outlook when you start Outlook or NEO. 
Here's how to address the problem. 

Ensure you are running the correct Microsoft versions 

NEO works with all Microsoft Outlook versions but does not work with Outlook Express. 

NEO also works with Exchange Server. For Exchange Server Version 5.5 Exchange Service 
Pack 3 or above must be installed. For Exchange 2000 Server,  Exchange Service Pack 2 or 
above must be installed. Your Exchange administrator can provide this information. 

Other ways email may not be properly configured 

NEO requires that both Microsoft Outlook and MAPI are properly configured on your 
computer. MAPI is an email subsystem that is normally installed when you install Microsoft 
Outlook. 

However, components of Outlook and/or MAPI can get corrupted. This can occur when you 
change versions of Microsoft Outlook or add new features, when you change modes such as 
from Internet Only Mode to Corporate or Workgroup mode, or when you use some other 
email programs that replace the correct version with their own versions of MAPI. 

Here are the steps to take to ensure your email subsystem is properly configured. All steps 
may not be required. You may want to print this topic by clicking the Print command on the 
Help toolbar.  

1.   Close NEO, Outlook and any other programs you have running. To be absolutely sure no email 
component programs are running it is best to restart your computer (assuming such programs 
don’t start automatically on startup). The following steps will not work if any part of MAPI is 
running. 

2.   Ensure “Microsoft Outlook” is your default email program. To change the setting: click Start, 
point to Settings, click Control Panel, then double-clicking the Internet Options icon. Click the 
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Programs tab, then choose Microsoft Outlook as the E-mail program. Do not choose Outlook 
Express.  

3.   Run the Microsoft FixMAPI program. This program does not exist on all computers. To find 
whether it exists on your computer, click Start, point to Find then click Files or Folders. Enter  
fixmapi.exe  in the Named field and click Find Now. If it is found, perform the following substeps:  

o    Click Start, point to Find then click Files or Folders. Enter  mapi32.dll  in the Named field 
and click Find Now. Right-click each copy found, click Rename and enter  mapi32.old . If 
you are not able to rename all files then MAPI is running and you should perform step 1 
above. Close the Find program.  

o    Click Start, click Run, enter  fixmapi.exe  in the Open field and click OK. This will run 
quickly and provide no confirmation information that it has completed.  

o    Restart your computer and try NEO.  

4.   Re-install Microsoft Outlook. Perform this step ONLY if step 3 above was unsuccessful.  

o    Click Start, point to Settings then click Control Panel. Double-click the Add/Remove 
Programs icon and then double-click Microsoft Outlook from the list. Have your install CD 
handy.  

o    After re-installation, restart your computer and try NEO.  

If none of the above steps correct the problem, please send an email to support@caelo.com 
describing your symptoms and what steps you have taken.     
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Using with Outlook 

Switching Between NEO and Outlook 

You can switch between NEO and Outlook in two ways: 

From NEO 

1. Click the Outlook button    on the toolbar,  or  

2. Press Ctrl+0. 

From Outlook 

1. Click the NEO button   on the toolbar,  or  

2. Click Tools menu | Switch to NEO Find. 

If the program you are switching to is not open, it will be opened. 

Interacting with Outlook items 

Here are actions you can take on Outlook items from within NEO: 

Switch quickly to Outlook 

Switch to an area in Outlook such as contacts, calendar in two ways: 

a)   Click the Outlook command on the NEO toolbar, or (or press Ctrl+0  (zero)) 

b)   Click the black triangle to the right of the Outlook command on the NEO toolbar and choose 
to go to a particular area of Outlook, or press these shortcuts to go to: 

               Ctrl+0   Outlook  
         Ctrl+1   Inbox     
         Ctrl+2   Calendar 
         Ctrl+3   Contacts 
         Ctrl+4   Tasks 
         Ctrl+5   Notes 
         Ctrl+8   Journal 

c)   Double-click an Outlook non-mail folder    in Outlook view. 

Work with Outlook mail folders   

In Outlook view, work with these just as you would your folders in Outlook. 

Interacting with Contacts and Address Books 

NEO interacts with Contacts in two ways. 
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When creating new Correspondent folders 

When automatically creating a new Correspondent folder, NEO imports relevant contact 
information such as name, company, telephone numbers and email addresses. 

NEO first checks to see if a Contact exists for the address based on an email address match. 
If a Contact matches, correspondent information is taken from the Contact. If no contact is 
matched, then NEO does a lookup in all Address Books for a matching entry. If a match is 
found, correspondent info is taken from the Address Book. NEO adds all addresses from the 
Contact/AddressBook to the Correspondent folder, except for addresses that already exist in 
NEO.  

Note that this is a one-time import from Contacts and is not synchronized in an ongoing way. 
If you make changes to the Correspondent fields they are not then reflected in your Contact. 

How NEO Works with Exchange Server 

NEO works with Microsoft Exchange Server mailboxes. However, NEO is an email organizer. 
It does not organize other Outlook object types such as calendar items, journal items, and 
note items. 

Here are some notes about using NEO with Exchange Server: 

NEO is a client-side product 

That means NEO installs and operates completely on your computer. There is nothing about 
NEO that gets installed on the server or that is related to Exchange Server. In fact, Exchange 
Server is completely unaware of NEO.  

You can organize your Mailbox, your PSTs and your IMAP folders 

If you are using NEO you can include your mailbox and as many PSTs or IMAP folders as 
you like in your catalog. NEO will give you a seamless view to all your messages as if they all 
reside in one large single area. 

Using your offline message store (OST) 

When using Offline mode, a Full Sync may sometimes be needed to updated deleted 
messages in NEO.  

Offline mode using Outlooks prior to Outlook 2003 

If you have offline access enabled (you use an offline message store), you should select 
all your email folders for OST/Mailbox synchronization. In addition, you should not set 
filters for your folders.  

You will not lose messages when you do this; however, if you do not include all your 
folders NEO may spend quite a bit of time removing and adding messages in the catalog 
each time you switch between your OST and your mailbox.  

If you have instructed Outlook to automatically Outlook synchronize your Exchange 
mailbox with your OST when exiting an online session, you must shut down Outlook 
without NEO running for the synchronize to be performed.  
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Cached Exchange Mode in Outlook 2003/2007 

NEO works with normally with Cached Exchange Mode.  

Reminder – Synchronize each time you re-connect to the LAN 

Whenever you re-connect to the LAN, you must synchronize to update NEO with new 
messages from your mailbox. Note that you can configure NEO to automatically Fast Sync 
on startup. 

Synchronizing with Outlook 

NEO normally displays all the messages in your message store(s). However, NEO doesn't 
know about new, changed or deleted messages that are processed when NEO is not 
running. 

How it works ... in a nutshell 

If NEO is running when new messages arrive, are changed or deleted, then you'll always see 
all your messages in NEO (NEO keeps you synchronized on-the-fly). 

If NEO is not running, then NEO will not know about these message events and will need to 
get synchronized again by you syncing manually (e.g., when you next start NEO). 

Always run NEO 

It’s best to always have NEO running when Outlook is running so your email stays 
synchronized. You can configure from the Tools | Options menu to start NEO together with 
Outlook. You can even select to start NEO minimized in the tray so it will never be in your 
way when starting Outlook.   
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NEO Views 

Overview - Views 

The power of NEO Find 

NEO Find contains Caelo’s patented short-cut technology to show messages automatically in 
more than one location without copying the message. 

NEO Find contains the three most frequently used views (Outlook, Correspondent and 
Search) for you to easily retrieve your emails. FYI: NEO Pro has nine different views. 

In views, messages appear in more than one location at the same time. Every message will 
always be in the Correspondent folder of the person communicated with. It will also always 
be in the Outlook folder containing the message. It can further be in a search results folder in 
the Search view if you find it in a search. Once a message is deleted, it will be removed from 
all your views. 

It is important to realize that the Correspondent Folders are always referencing ALL 
messages from a single Correspondent (whether Sent or Received). So, even when a 
message is moved within the Outlook system (e.g. from the Inbox to another folder), it will 
still show in the Correspondent Folder as if it did not move – in fact, the reference in the 
Correspondent Folder for this message is automatically updated to the new location when 
moving a message (you can see the changed location in the Preview Pane where the 
containing folder is shown). 

In short, even though you see the same message in different views, it’s really just one 
message presented to you in different ways. 

This now is the beauty of NEO Find: although messages may move within your Outlook 
system (and you may forget where it is filed away), you will always find all your messages to 
or from a person in the Correspondent Folder – no matter where it is located in your Outlook 
system. 

Using views 

Views don’t require any work – they’re set up and maintained automatically for you to use. 
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Outlook View 

 
Outlook View 

Outlook view is your view into your Outlook 
Folder List. 

The example at left shows multiple message 
stores (PST files).    

Correspondent View 

 

Correspondent View 

Lists all people you correspond with. These 
include people you send messages to and 
people who send messages to your email 
address(es). 

Although these folders are virtual folders (they 
do not exist in reality in your Outlook system), 
they behave like real folders – most importantly 
you can search through these folders using the 
Search facility (press F6 to launch a Search in 
Folder).    
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Search View 

 
Search View 

NEO's search is an indexed search facility. It's 
extremely fast because all the words in all your 
messages are automatically indexed. 

Besides a search through the entire Outlook 
system, Search is particularly powerful to 
search through the virtual Correspondent 
Folders (select a Correspondent Folder and 
press F6 for a Search in Folder) 

In NEO Find you can save search folders (as 
shown at the bottom).         
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Working with Messages 

Once messages are found 

Once you have found a message (see Chapter: Finding Emails), you can perform several 
actions. 

Open a message  (Enter or Ctrl+O) 

Double-click a message in list view, or select a message and press Enter of Ctrl+O to open a 
message in Outlook. 

View message thread  (F7: Search for Conversation) 

  Press F7 to find related messages in same conversation thread (see below). 

Reply to a message   (Ctrl+R) 

Click the Reply toolbar command, or enter Ctrl+R. After entering the message contents, 
click Send. 

Reply to all respondents in a message   (Ctrl+Shift+R) 

Click the Reply All toolbar command, or enter Ctrl+Shift+N. After entering the message 
contents, click Send. 

Forward a message   (Ctrl+F) 

Click the Forward toolbar command, or enter Ctrl+F. After entering the address 
information and the message contents, click Send. 

Jump to Folder   (Ctrl+J) 

  Jump to the containing folder of the message. When folder is organized in more than one 
folder, a selection screen will show to select the folder to jump to. 

Use message as attachment 

When you like to add the message as attachment to a new message, simply drag-and-drop the 
message from NEO’s message list to the new mail window. 

File message to another folder   (Ctrl+F) 

Right-click the message and select File to Any Folder. 

Mark Read/Unread   (Spacebar / Shift+Spacebar) 

Pressing Spacebar or Shift+Spacebar will mark a message Read or Unread. 
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Delete a message   (Del) 

Simply press the Delete key to move a message to the Deleted Items folder. Pressing Ctrl+Z will 
undo this delete action. 

Moving Back and Forward 

Use the back and forward commands to quickly jump back or forward to previously-visited 
folders. This is very useful, for example, after performing a search. 

The Back and Forward buttons are located on the right side of the header above the list 
columns: 

     

Or press Alt+Left for Back or Alt+Right for Forward. 

Search on Conversation   

To quickly see all related messages: 

         Click    on the Standard toolbar, or 

         Press F7. 

You will then be quickly positioned in Search view with all messages based on the same 
'conversation' displayed.     

When done, click     or press Alt+LeftArrow to go back to the folder your came from. 

About 'Conversation' 

Every message has a property called Conversation, and it is usually the same as the Subject 
property but it can be different. 

When a new message is created, the current Subject is copied to the message's 
Conversation. However, if the Subject is edited, the two will be different. Conversation 
always remains as the original Subject. 
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Deleting Messages 

Deleted messages go to Deleted Items 

To delete a message or messages, highlight the message(s) and press the Delete key 

When messages are deleted in NEO they are moved without warning to your Deleted Items 
folder in Outlook. You can get them back if you need to by moving them from Deleted Items 
to another folder or by pressing Ctrl+Z (Undo) immediately after the delete action. 

Note:    When you delete a message, the message will be removed from all views within NEO. 

Deleting saved search folders  (Alt+Del) 

If you delete a saved search folder (Alt+Del), just the saved search results are deleted – the 
underlying messages remain. 

Undoing Actions 

You can UnDo (reverse) some operations in NEO. Keep in mind that only the last action can 
be undone. 

To UnDo an action, press Ctrl+Z or select UnDo from the Edit menu.   
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Viewing Message Properties 

Right-click any message in list view then click Message Properties.  

Location lists the NEO folders that contain the selected message. This is especially useful 
for determining in what Correspondent and Outlook folder a selected message is stored in. 
Note that you can also see what Outlook folder a message is stored on the Folder field on 
the Reading Pane header.   

Message Symbols 

See Reference section at end of Help.   
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Working in the Reading Pane 

NEO’s Reading Pane 

The Reading Pane displays beneath or to the right of the Message List Pane. 

Reading Pane Options 

These options relate to the Reading Pane.  
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Clicking Links to Launch Your Browser 

If your browser is open when you left-click a web link, the page replaces the current page 
loaded in your browser.  To launch a web-link in a separate browser window, left-click the 
web link while holding down the Shift key. 

Click link Launch web-link in your current browser window (replacing currently loaded 
page).   

Shift+Click link Launch web-link in a new browser window. 

See keyboard shortcuts on the Help menu for a list of all keyboard shortcuts. 

Resizing the Reading Pane 

The Reading Pane can be positioned either at the bottom or to the right of the screen. This 
can be defined on the View menu. Size of the Reading Pane can be changed to any desired 
size by dragging the pane separator to a new location or by using the keyboard shortcuts. 
Switching off the Reading Pane can be done through the View menu. 

Keyboard shortcuts  

Ctrl + Alt + Up Reading Pane On 
Ctrl + Alt + Down Minimize Reading Pane 

Shift + Ctrl + Up Increase Reading Pane 

Shift + Ctrl + Down Decrease Reading Pane 
Shift + Ctrl + PageUp Maximize Reading Pane 

Shift + Ctrl + PageDown Restore Reading Pane  

Note that you don't have to see the List Pane messages in order to read them in the Reading 
Pane. You can use the following shortcut keys to move from message to message: 

Ctrl + Up                    Move to previous message  
Ctrl + Dn                    Move to next message 

Changing Reading Pane Fonts 

There are three message formats for the Reading Pane: HTML, Microsoft Outlook Rich Text, 
and Plain Text. Here's how the change the text characteristics. 

HTML messages 

Change the relative size of HTML text in two ways:  

o    Click View menu | HTML Text Size. 

o    Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 
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Plain text messages 

Change the characteristics of Plain Text messages:  

o    Set on via Reading Pane options (Tools menu | Options | Reading Pane tab)  

Microsoft Outlook Rich Text 

This message format cannot be modified in the Reading Pane.   

Choosing the HTML Reading Pane Viewer 

What is the HTML Reading Pane? 

Messages displayed in the Reading Pane are displayed in one of three formats: Plain Text, 
Rich Text, or HTML. The HTML Reading Pane Viewer displays messages when they are in 
HTML format. 

In NEO, the default HTML Reading Pane Viewer is the Microsoft HTML Viewer. This is the 
same viewer that is used in the Outlook Reading Pane.  Our Internal HTML Viewer is a 
simpler viewer with considerably less extensive display capabilities. 

Which viewer should you use? 

We recommend that you use the Microsoft HTML Viewer. Here are the differences between 
the two.  

Microsoft HTML Viewer

 

Internal HTML Viewer

 

Works with Internet 
Explorer versions 5.0 and 
above (not selectable with 
pre-IE5.0) 

Works with Internet 
Explorer versions 4.0 
and above. 

Displays messages just 
like Outlook does in its 
Reading Pane. 

Does not display some 
HTML objects as well. 

Faster display when 
moving from message to 
message. 

A little slower. 

Email security (see 
below) 

Email security (see 
below) 

More information about Email Security 

In general, message Reading Panes can and have been vulnerable to email viruses. 

When choosing the Microsoft HTML Viewer, NEO uses the security zone settings in Outlook 
in Options | Security. Taking it one step further, NEO also ensures scripts will never run and 
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ActiveX controls are deactivated regardless of your version of Outlook or security zone 
settings. Note that using the Microsoft HTML Viewer in the NEO Reading Pane is no riskier 
than the Outlook reading/preview pane, and may be safer. 

The Microsoft HTML Viewer is a component of Microsoft Internet Explorer. You get the latest 
version whenever you update your Internet Explorer. To minimize security risks Microsoft 
strongly recommends that you periodically download and install the latest critical security 
updates for Internet Explorer, which can be obtained from 
http://www.microsoft.com/windows/ie/default.asp. This can be automated if you wish by using 
Microsoft's Windows Update. 

NEO's Internal HTML Viewer is safe regardless of your version of Outlook or your security 
zone settings, but is not as rich in its display capabilities. 

Note:  We may discontinue support for the Internal HTML Viewer in future versions of NEO.      

http://www.microsoft.com/windows/ie/default.asp
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Filtering 

Filtering Overview 

Filtering is ability to temporarily show certain types of messages. It's great for zeroing in on 
certain types messages such as Sent or Received messages.  

Filter basics 
         Filters are fast. They can be set and cleared very quickly. 

         Filters are temporary. They never affect your messages, just what folders or messages that you 
see. You can always clear them. 

         Filters are global - they operate across all message stores, views and NEO folders.  

         Filters are sticky - if you set a filter it remains in place until you change it, even if you restart 
NEO. 

         When a filter is 'on', the background of the List Pane and/or the Folder List changes color to 
make it obvious a filter is applied. 

Filtering in NEO Find 

NEO Find has a Filter toolbar. The Filter toolbar consists of filter sets that fit together 
logically. You can combine your filters in any combination that you like. 

Below the Filter toolbar is shown in its filter sets:    

Filter Controls:  Clear clears the filter so that all 
messages show. Disable, temporarily disables the 
filter so you can quickly see all the messages. 
Clicking Disable again reinstates your current filter.   

Folder:  Shows only folders with Unread 
messages. This filter is a folder filter and acts on the 
Folder Lists.  

Message Status:  Choose from Unread, Unfiled, 
Flagged or Important, singly or in any combination.   

Direction:  Show Received messages only or Sent 
messages only.  

Date filter:  A flexible From… To… filter.   

Message age in Days:  Message age from today. 1 
day shows today's messages, 2 days shows today's 
and yesterday's messages, and so on. 
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How to tell when a filter is on 

Whenever a filter is on, the background color of parts of NEO display in a different color. For 
folder filters ('Show folders with Unread'), the Folder List background color is changed. For 
message filter sets (all others) the Message List Pane background is colored. You can 
change the background color in options. 

Clearing a Filter 

To clear the filter in NEO, simply click the filter commands again so that they are disabled 
(they show without a border).    
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Folder Lists 

Overview to Folder Lists 

Each NEO view has its own Folder List. When a folder in the list is selected its messages are 
displayed in the List Pane.     

Folder Basics 
Folders are containers for your messages. The operations you can perform on folders vary 
depending on the type of folder. To see the available operations for a folder, right-click the 
folder. Here's are the available operations for a Correspondent folder: 
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Common folder operations 
Search in folder          Go to Search view with the folder selected for searching. 

Combine folders        Combine one folder with another. You can also drag and drop the source 
folder onto another. 

Remove folder           Delete a folder without deleting the underlying messages - Alt+Del. 

Rename folder           Change the name of a folder - F2. 

Folder properties        View the folder properties - Enter or double-click. 

Special folder operations 
Empty folder              Permanently delete the folder's messages (available for Deleted Items and 

Spam Folders).  

Make Current              For views containing the New, Current, Dormant folders, move folder into the 
Current area. 

Make Dormant            For views containing the New, Current, Dormant folders, move folder into the 
Dormant area. 

Refresh search           Re-run a search folder to update it based on its search parameters. 

Jump to Outlook        Jump to the corresponding Outlook folder. Do this for Contacts, Calendar, etc. 
as well as your user-defined folders - Enter or double-click. 

Finding Folders in the List 

The fastest way to find a folder in long Folder Lists is to use the Folder List Filter. Enter 
characters into the textbox at the top, and the list will display only those folders with the 
characters in it. 

For example, to quickly find Mary Jennings folder, entering 'mary' is sufficient to reduce the 
folder set to a small enough set to select it. 
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Notice that when a filter is in effect, the background is displayed in the filter background 
color.  

Here are some shortcut commands to make working with the Folder List Filter easier: 
Esc

 

Clear the Folder List Filter 

F3

 

Jump to the Folder List Filter in the current view 

F5 Jump to the Correspondent Folder List Filter.  
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Sorting the Folder List 

Each view can have its own sort order. Change the sort order by clicking one of the three 
buttons at the top right.  

Expanding and Collapsing the Folder List 

When in Tree Sort Order, the tree displays in a hierarchy. Expand a branch by clicking the 
Plus  symbol. Collapse a branch by clicking the Minus  symbol. 

Keyboard shortcuts (using the number keypad): 
Num +                    Expand current folder in Folder List 

Num -                     Collapse current folder in Folder List 

Shift+Ctrl+Num +   Expand all folders from anywhere in list 

Shift+Ctrl+Num -    Collapse all folders from anywhere in list 

Top-level folders – New, Current and Dormant 

Some views have top-level folders. Top-level folders are folders managed automatically by 
NEO to help you organize your folders. You can also organize folders in top-level folders 
manually. 
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In Correspondent view the New top-level folder displays all folders that have been newly 
created.. 

Automatic organization 

You can choose to have NEO automatically move Correspondents from New to Current, and 
from Current to Dormant based on day-age parameters you provide.  You can also specify 
that Dormant folders are moved back to Current when they become active again (e.g., 
receive a message). 

You could specify that New folders automatically move to Current after 30 days, and Current 
folders automatically move to Dormant after 365 days of inactivity. A folder remains inactive 
until a significant event occurs such as it receives a message.  

By disabling automatic moving of folders you would retain control over where a folder is 
located. 

To set the automatic organization of folders, right-click a top-level folder such as New, 
Current and Dormant and choose Folder Properties. 

Manual organization 

You can manually move folders from New to Current, Current to Dormant and so on in two 
ways: 

1. Drag and drop the folder from one group onto the branch of the other. Drop it on the top-level 
folder itself (e.g., Current). It you drop it on a folder, NEO will think you wish to combine folders. 

2. Right-click the folder and choose Make Current or Make Dormant.   
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Folder Properties 

General Folder Properties 

These properties apply to all Search folders.     

Top-level folder properties 

Top-level folders group your folders at the highest level.     
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Correspondent folder properties 

These properties apply to Correspondent folders.      

Back to Table of Contents

 


